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1 Introduction 
reelektronika’s Differential eLoran Reference Station is designed to calculate 
differential eLoran corrections for a set of eLoran stations at a particular Reference 
Station Location. The correction data is communicated in real-time via a secure VPN 
connection to a Eurofix equipped eLoran Transmitter. The basis for this Reference 
Station is reelektronika’s eLoran receiver, which was released early 2005. The 
standard receiver has been modified with additional hardware logic and analogue 
electronics to allow maximum flexibility in functionality of the receiver. Further, the 
receiver’s firmware has been modified to allow processing and outputting of the 
additional measurements.  
 
The receiver is designed for differential eLoran monitoring applications and requires 
trained eLoran experts in order to control and interpret the measurements taken by the 
unit.  
 
This manual describes the hardware of the Differential eLoran Reference Station and 
the software to configure, control and monitor it. For this purpose the Differential 
eLoran Reference Station is equipped with an onboard PC platform running Windows® 
XP and Reelektronika’s Differential eLoran Reference Station application. As the 
receiver is based on reelektronika’s integrated GPS/eLoran receiver the general 
operation of the receiver is described in its manual. The latest version of the manual 
can be downloaded from www.reelektronika.nl. 
 

1.1 Functional description 
The Differential eLoran Reference Station consists of the following: 

1. The LORADD eLoran receiver engine 
The LORADD engine is the heart of the Differential eLoran Reference Station. It 
provides the eLoran digital signal processing, acquisition of stations and eLoran 
measurements. 

2. The eLoran Digital Platform 
The eLoran Digital Platform provides real-time accurate digital processing of the 
timing signals from eLoran and GPS, necessary to tie eLoran and GPS 
measurements to a common time reference (UTC). It further supplies an 
accurate eLoran simulator signal for real-time calibration of the H-field antenna, 
analogue and digital processing paths through the receiver. 

3. Temex SRO GPS disciplined Rubidium oscillator 
The Rubidium clock provides a stable clock source to improve the tracking of 
the eLoran signals and additionally provides a 1 PPS to tie eLoran and GPS to 
a common timeframe.  

4. Motorola MT12 GPS timing receiver 
The Motorola MT12 GPS timing receiver is used to discipline the Temex SRO 
Rubidium oscillator. This way, the Differential eLoran Reference Station is 
provided with an accurate absolute clock synchronised to UTC.   

5. Differential eLoran Reference Station PC platform 
Differential eLoran Reference Station PC platform is integrated into the housing. 
The PC platform runs Windows® XP and Reelektronika’s Differential eLoran 
Reference Station application for configuration, control, monitoring and data 
logging. 
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6. eLoran H-field antenna 
The eLoran H-field antenna is modified to accept a simulator signal input for 
real-time calibration. The simulator signal is tracked by the LORADD engine to 
provide the calibration measurements. The antenna also houses a GPS patch 
antenna for the GPS timing receiver. 

 
Figure 1 shows the functional block diagram of the Differential eLoran Reference 
Station with all its components.  
 
The Differential eLoran Reference Station calculates a set of differential corrections 
based on the TOA measurements and pre-set ASF values. The Differential eLoran 
Reference Station application selects a couple of corrections for broadcast and 
communicates them to the Eurofix equipped eLoran transmitter.  
 
Part of the monitoring functionality of the Differential eLoran Reference Station is 
Horizontal Positioning Error monitoring. For this, the LORADD Receiver engine is fed 
with a single point ASF map consisting of the nominal ASF values. The receiver than 
calculates a “zero-baseline” position solution based on the measured TOAs, the ASF 
map and received differential corrections. The resulting position error exceeds the set 
Horizontal Protection Limit an alarm is raised. 

 
Figure 1 – Functional block diagram of the Differential eLoran Reference Station. 



Differential eLoran Reference Station reelektronika 

version 1.0  
 
 

3 
 
 

2 Installation 
Installation of the Differential eLoran Reference Station should be performed carefully. 
The quality of the installation directly reflects on the quality of the provided Differential 
eLoran service provided through the station. Special attention should be placed on the 
H-field antenna installation. The Differential eLoran Reference Station measurements 
allow analysis of the chosen antenna location.  

2.1 Differential eLoran Reference Station hardware 
input/output 

Figure 2 shows the front and the back side of the Differential eLoran Reference Station.  
 
On the front panel of the Differential eLoran Reference Station the following status 
LEDS are available:  
 

LED Description 
Clock Indicates whether the Rubidium is locked to the GPS 

PPS input 
eLoran Indicates whether a valid eLoran position is available 

Differential Data Indicates whether Differential Data is available 
Communication Indicates whether Communication with the Eurofix 

installation is established 
Alarm Indicates whether the Differential eLoran Reference 

Station raised an alarm 
Power Indicates whether the Differential eLoran Reference 

Station is powered on 
 
On the back the following connectors are available (from left to right): 

- 3-pin 100-240 V AC power connector. 
- Panel with standard PC connectors (COM1, LPT1, VGA, LAN, USB, Mouse, 

 

Figure 2 Differential eLoran Reference Station front view (top) and rear view (bottom) 
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Keyboard) 
- 1 DB9 male comport connectors COM2, connected to COM2 of the PC 
- 1 DB9 female comport connectors COM3, connected to COM2 of the LORADD 
- 1 DB9 male connector AUX1 for future use 
- 1 DB9 female connector AUX2 for future use 
- 1 TNC GPS connector 
- 1 8-pin antenna connector (LEMO) for connection of the eLoran H-field antenna 
- 12 BNC input/output connectors 
 

Below a further description of the connectors is given.  
 

2.1.1 H-field antenna connector 
The H-field antenna connector is the same as the antenna connector for all other 
LORADD Series equipment and can be connected to reelektronika’s H-field 
antenna using a standard antenna cable. In addition to the standard inputs, the 
antenna connector provides a simulator signal for calibration purposes consisting of a 
standard Master sequence of Loran pulses at a user selectable GRI (default 7823).  
 
The connector on the Differential eLoran Reference Station is LEMO ECG.1B.308; the 
cable connecter should be LEMO FGG.1B.308 to match. 
 
Pin layout as seen from the outside of the housing: 

1

2 3
4

5
67

8

 

Pin 1: Channel 1+ 
Pin 2: Channel 1- 
Pin 3: +5 V DC  
Pin 4: Channel 2+ 
Pin 5: Channel 2- 
Pin 6: Simulator Signal 
Pin 7: Reserved 
Pin 8: Ground 

 

2.1.2 Comports 
The comports on the Differential eLoran Reference Station are provided for 
troubleshooting and maintenance purposes only. No external comport connection is 
necessary for the proper functioning of the Differential eLoran Reference Station. 
 

COM1 On the standard PC panel is COM1 of the PC 
COM2 COM2 of the PC 
COM3 COM2 of the LORADD 

 

2.1.3 BNC Input/Output connectors 
The 12 BNC connectors for input and output are provided for troubleshooting and 
maintenance purposes only. No connection to any BNC is necessary for the proper 
functioning of the Differential eLoran Reference Station. By default the BNC connectors 
are assigned as described below. 
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Port Description Input/Output 
BNC 1 Simulator Output Out 
BNC 2 10-MHz Sine wave Clock Output (Temex SRO-100) Out 
BNC 3 Simulator Trigger Output Out 
BNC 4 Spare Out 
BNC 5 1PPS Output of Temex SRO-100 Out 
BNC 6 1PPS Output of Reference Out 
BNC 7 Spare NC 
BNC 8 Spare Input 
BNC 9 Spare Input 
BNC 10 Spare Input 
BNC 11 Spare Input 
BNC 12 Spare Input 

 

2.1.4 H-field antenna and antenna cable 
The Differential eLoran Reference Station comes with a reelektronika H-field 
antenna. This antenna is modified to accept the eLoran simulator signal from the 
Differential eLoran Reference Station. 
  
The eLoran antenna is integrated with a GPS patch antenna which needs to be 
connected to the Differential eLoran Reference Station to feed the GPS signals to the 
Motorola timing receiver.  
 
The eLoran antenna is an active antenna. Therefore, the LORADD receiver outputs 
+5 V DC on pen 6 of the eLoran antenna connector. Figure 3 shows the integrated 
eLoran/GPS patch antenna. 
 
The H-field antenna is connected using an 8-wire Tasker C185 cable. On the receiver 
end, the cable is connected using a LEMO FGG.1B.308 connector. On the antenna 
end the cable is connected using a CONXall Multi-Con-X282-92G-3XX connector. The 
cable is connected to the connectors using the following pin information and cable color 

  
Figure 3 H-field antenna with GPS patch included 
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codes: 
 

CONXall Multi-Con 282-9SG-3XX 

cable connector female 

solder side 

(TASKER C185 colorcode) 

1

2

3 4 5

6

7

8

9

white/green

green

white/yellow
yellow

whit
e/r

edred

graywhite/gray

cable shield

 

LEMO FGG.1B.308 

cable connector male 

solder side 

solder side

1
2

3
4 5

6

7
8

 

Connector @ antenna 
(CONXall Multi-Con-X 282-

9SG-3XX) 
1. CH 1+ 
2. CH 1- 
4. CH 2+ 
5. CH 2- 
3. +5V (200 mA) 
8. GND 
6. Simulator 
7. Reserved 
9. Shield 

Cable colour 
(Tasker C185) 
 
gray 
white/gray 
yellow 
white/yellow 
red 
white/red 
green 
white/green 
cable shield 

Connector @ receiver 
(LEMO 308: 

FGG.1B.308.CLCD72) 
1. CH 1+ 
2. CH 1- 
4. CH 2+ 
5. CH 2- 
3. +5V (200 mA) 
8. GND 
6. Simulator 
7. Reserved 
Connector shield 

The shield of the antenna cable is connected with the LEMO 308 housing  
and with pin 9 of the CONXall connector 

 
CH1 and CH2 indicate the signals coming from the two separate antenna rods in the 
H-field antenna. 

2.2 The Motorola M12+ GPS receiver 
The Differential eLoran Reference Station is equipped with a Motorola M12+ GPS 
receiver providing GPS derived timing signals. The GPS receiver communicates 
directly to the LORADD receiver, but can also be accessed through COM3 of the 
Differential eLoran Reference Station. Default this comport is configured to 
communicate at 115200 baud. Please refer to the M12+ user manual [Motorola] for 
further instructions on the GPS receiver  
http://www.synergy-gps.com/images/stories/guides/m12+userguide.pdf, the WinOncore 
windows program can be downloaded at  
http://www.synergy-gps.com/images/stories/exe/WinOncore12_1_2.zip   
 
The LORADD receiver initiates the following configuration commands to the GPS 
receiver at start-up. The GPS receiver does not have non-volatile memory to store 
settings, therefore the receiver reverts to these default settings every time the 
LORADD receiver is power cycled. Motorola configuration commands are: 
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@@Hb01 // Output short channel msg once per second 
@@Hn01 // Output TRAIM Status message once per second 
@@Ge01 // Enable TRAIM 
@@Gc03 // Output PPS only if TRAIM valid 
@@Bo01 // Request UTC offset, every time it is updated 
 
For proper operation of the GPS components within the LORADD-UTC receiver, the 
receiver assumes the above configuration is present. 

2.3 Installation guidelines 
The Differential eLoran Reference Station is delivered with all software pre-installed 
and tested. After hardware installation the Differential eLoran Reference Station only 
needs to be properly configured. Installation requires the following steps: 

1. Install the 19” Differential eLoran Reference Station equipment in a dry and air-
conditioned room. Connect Monitor, Keyboard and Mouse. Connect a network 
cable to the Local Area Network and make sure the Differential eLoran 
Reference Station has access to the internet. After boot, the Differential eLoran 
Reference Station application will start automatically.  

2. Install the eLoran and GPS antenna cables. Make sure you know the length of 
the cables for configuration purposes. Follow the guidelines below (Section 
2.3.1) for installing the H-field antenna. 

3. Configure the Differential eLoran Reference Station according to Section 3.1. 
After initial configuration the settings are stored in Windows XP’s registry and 
reloaded every time the Differential eLoran Reference Station application is 
restarted.  

For secure communication between different components of the eLoran network, a 
Virtual Private Network is set-up using OpenVPN. The Differential eLoran Reference 
Station communicates over the VPN with the Eurofix Reference Station in Anthorn to 
broadcast the differential corrections. The VPN will automatically be set-up after boot-
up of the Differential eLoran Reference Station. In case the VPN is not configured 
properly the reader is referred to Section 2.3.2.  
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2.3.1 Installation of the H-field antenna 
For installation of the antenna the following guidelines have to be taken into account. 
The H-field eLoran antenna needs to be installed in a location free from interference in 
the 100 kHz frequency range, such as computer monitors, processors, power supplies 
or other electrical equipment, spark ignition engines or engine alternators. The 
presence of these noise sources may limit the eLoran performance of the Differential 
eLoran Reference Station. Further, antenna installation close to large metal objects 
might have a negative influence on the accuracy of reception of eLoran signals due to 
reradiation. Although the reradiation effects are likely to remain constant over time, it is 
bad practice to operate a Differential eLoran Reference Station in a reradiation rich 
environment.  
 
The arrow of the antenna housing need not be pointed in any particular direction in 
case of static operation. In dynamic applications, the H-field antenna allows 
determination of real headings even without movement of the vehicle.   
 
For eLoran signal environment analyses the receiver is capable of outputting a 
received spectrum (FFT) plot of both H-field loops combined, through the FFTA log, 
which can be made visible in the Differential eLoran Reference Station application. 
Figure 4 shows the FFT screen with the location of the notches. For this view the FFTA 
and NOTCHA logs need to be enabled. See Section 4 for more information on these 
logs.  

2.3.2 Virtual Private Network 
In order to secure the communication between a Eurofix Reference Station (at the 
eLoran transmitter site) and remote clients (such as a Differential eLoran Reference 

Figure 4 Screen capture of FFT screen 
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Station), it is recommended that the eLoran communication is done over a Virtual 
Private Network. This helps in preventing unauthorized access to the communication 
between the various components of the system, as well separating the communication 
from other traffic and thus making IT Network management easier. 
 
For this purpose, the computer running the Local System Controller of the Eurofix 
Reference Station is set up as an OpenVPN server. The server listens at port 5901. 
More information regarding OpenVPN can be found at http:// openvpn.net . 
 
The basics of the OpenVPN authentication are as follows: 
 

- Each of the nodes in the VPN has its own secret Key. 
- Each of the Keys has an associated Certificate. The Certificate is public. 
- The Certificate has been issued by a central Certificate Authority (CA). 
- The Certificate Authority itself also has a Certificate which is know to all nodes. 
- Using the CA Certificate, all nodes are able to verify that a given Key Certificate 

carries a valid Certificate Authority signature. 
- Successful communication between two nodes is established when both sides 

have verified that they each have keys that have been signed by the (trusted) 
Certificate Authority. 

 
To configure an OpenVPN client, 4 files are necessary: 

- ca.crt . This is the certificate of the (trusted) Certificate Authority. It is the same 
for all nodes in the VPN. 

- Client_xx.key . This file contains the key for this particular node. Each node 
should have a unique key. This file should be kept secret. 

- Client_xx.crt . This is the certificate that carries the CA’s signature generated 
based on the Client_xx.key file. 

- Client.ovpn . This file contains the configuration of the client-side of the VPN 
connection. Apart from specific references to the key and certificate files for this 
particular client, the configuration is equal for all client nodes. 

 
All 4 files should normally be stored in C:\Program Files\OpenVPN\config . 
 
The OpPenVPN server is configured in such a way that it acts as a DHCP server. It 
itself has IP address 192.168.101.1 . Each of the Clients will receive an address in the 
192.168.101.x subnet. The Clients are identified based on the Key that they provide. 
Once a Client has been issued an IP address, this IP address will be reserved and re-
issued every time the Client reconnects to the Server. The IP address will not be 
provided to other Clients. 
 
The server is configured to allow client-to-client communication via the VPN. All 
communication will pass through the Server, though. 
 
The Differential eLoran Reference Station communicates to the Eurofix Reference 
Station via the OpenVPN server in order to have the differential corrections broadcast 
over Eurofix.  

2.4 Firmware updates 
The Differential eLoran Reference Station consists of three processing platforms: 

- The standard LORADD-OEM DSP type receiver board 
- The LORADD-FPGA digital signal processing board 
- The Differential eLoran Reference Station application on the PC 
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Contrary to standard LORADD receivers, firmware updates are not provided through 
reelektronika’s website. If you require firmware or FPGA updates, please contact 
reelektronika directly.  
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3 Operation of the Differential eLoran Reference Station 
The Differential eLoran Reference Station is specialised eLoran equipment and 
requires trained eLoran experts to control and interpret the measurements taken by the 
unit.  
 
At boot-up the VPN connection will be made and the Differential eLoran Reference 
Station application will automatically start using the settings saved in the Windows XP’s 
registry.  
 
Operation of the Differential eLoran Reference Station is described in three sections; 
Configuration, Monitoring and Status Reporting, and Troubleshooting.  

3.1 Configuration 
After the installation or reinstallation of the Differential eLoran Reference Station the 
following connections and settings need to be configured before correction generation 
can commence: 

1. Connection to the internal LORADD Engine and the Eurofix Reference Station 
2. Differential eLoran Correction generation configuration 

 
Once properly configured, the Differential eLoran Reference Station operates 
automatically, even after a reboot.  

3.1.1 Connection to the internal LORADD Engine and the Eurofix 
Reference Station 

By opening File->Data source on the Differential eLoran Reference Station application 
menu the following form is displayed: 
 

 
 
The internal LORADD receiver engine is connected using COM3@115200 baud. The 
connection to the Eurofix Reference Station is made through the VPN to 192.168.101.1 
port 5911. By ticking Automatic reconnect the application will reconnect in case of 
loss of communication. 
 
If all connections are made correctly, the Application will show communication logs on 
the eLoran Receiver I/O (LORADD) and eLoran Transmitter I/O (RSIM) monitor forms. 
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The Application can also be used to replay recorded log files for post-processing data 
analysis purposes. For this, the LORADD and Eurofix Reference Station should be 
disconnected before a log-file can be selected. 

3.1.2 Differential eLoran Correction generation configuration 
By selecting View->Differential eLoran Configuration from the Application menu, the 
following form is displayed: 
 

 
 

This form allows for the configuration of the LORADD Engine’s and Application’s 
correction generation parameters and consists of the following fields: 
 

Reference Station 
Field Default Description 
Reference Station Name  Alphanumeric name (no spaces) 
Reference Station ID  Unique ID between 0 and 1023 
Latitude  In degrees, decimal degrees 

Longitude  In degrees, decimal degrees 

Correction Update 30 Interval in seconds before a new set of 
corrections is broadcast 
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Correction Priority 1 Number of Eurofix messages allowed to 

proceed before the differential 
correction message is issued (0 is 
immediate broadcast) 

 

The Reference Station position needs to be surveyed to within 1 meter accuracy.  
 

Differential eLoran Almanac 
Field Default Description 
eLoran ID  In eLoran format XXXXC with XXXX the 

4 digit GRI and C the Station indicator 
(M,X,Y,Z) 

Nominal ASF  Nominal ASF value in µs at the 
Reference Station location. Corrections 
will be calculated with respect to this 
value. 

 
The differential eLoran corrections are broadcast in sets of 2 corrections each. The 
Eurofix data format is given in Annex A. In case the operator wants to disable the use 
of a certain Loran station, the Eurofix message content for that station can be set to 
“Do not use” by unticking the checkbox before the Loran ID field. 
 

Differential eLoran Integrity Monitoring 
Field Default Description 
Horizontal Protection Limit 25.0 HPL in meters 

HPL Observation Interval 10 Interval in seconds 
Max ASF Correction 2.046 Maximum ASF correction value allowed 

to be broadcast. The data format allows 
for corrections between -2.046 and 
2.046 µs. 

 
If the calculated horizontal position error exceeds the HPL for the duration of the 
Observation Interval an alarm is raised. If the receiver reports positions within the HPL 
for the duration of the Observation Interval the alarm is cleared again. 
 
Every time a change is made to the configuration, the LORADD engine needs to be 
reconfigured and restarted. If a reconfiguration is necessary the caption of the push 
button Configure Reference Station is bold. By pressing the button, the Application 
will configure the Receiver and issue a restart.  
 
All settings are automatically stored in Windows XP’s registry. 

3.2 Monitoring and Status Reporting 
The Differential eLoran Reference Station application provides tools to monitor the 
operation of the station and log data. The status of operation of the Differential eLoran 
Reference Station is presented by the status LEDs and is repeated on a Status form, 
as shown below. Additionally, the status of the Horizontal Position Error Monitoring is 
presented too. In case the station identifies a problem with the Rubidium clock, the 
eLoran data reception, the differential correction generation, communication with the 
Eurofix Reference Station or horizontal position error an alarm is raised. 
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The main window of the application contains forms with detailed information on the 
measurements on which the differential corrections are based, of which the TOAA log 
display, the calculated eLoran position (LCPOSA), the Rubidium clock feedback 
(PTNTA) are displayed here. 
 

 
 

    
 
The most recently calculated differential correction set is presented in the following 
form. 
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By selecting View->TOA and Differential Corrections Monitor Plot the TOA 
measurements and calculated differential corrections can be monitored graphically. 
The form allows for different viewing modes and presents statistical information. 
 

 
 
By selecting View->Differential eLoran Position Error Monitor Plot the horizontal 
position error monitoring can be viewed. The red circle represents the protection limit, 
which can also be altered in the form. The graph represents a scatterplot around the 
surveyed centre position and can be scaled. Statistical information is available where 
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the “Avg err” represents the statistics with the offset removed and the “Real err” with 
the offset present. 
 

 

3.3 Troubleshooting 
This section will give guidelines for troubleshooting in the form of a “frequently asked 
questions” guide. 
 
In order to do the troubleshooting, make sure all connections are made properly and 
the Differential eLoran Reference Station application is running. 
 
Questions regarding the operation of the Differential eLoran Reference Station  
Q1: The station does not light any LEDs. 

A1: - Check if the power cord is properly connected, input is 100-240 V 50/60 Hz 
mains.  
- Check if the fuse at the back of the power connecter is broken 
- If the power is connected and the switch is turned on, the power LED should be 
lit. 

 

Q2: The station is turned on, and the power LED is lit. However, the Clock LED is off. 

A2: The Clock is disciplined by the Motorola MT12 GPS receiver. If the Clock LED is 
off the Motorola is most likely not getting any valid GPS.  
- Check if the station outputs PTNTA messages and verify what its status is. 
- Check if the GPS antenna and cable are properly installed, with a clear view at 
the sky.  
- Allow for at least 15 minutes for the GPS receiver to settle. 
- View status of the GPS receiver through WinOncore program and comport 
pass-through program for the LORADD receiver. 
- Use the WinOncore software and Motorola receiver manual to troubleshoot the 
GPS receiver. 

 

Q3: The station is turned on, and the power LED is lit. However, the eLoran LED 
remains off. 
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A3: The eLoran LED is triggered by the availability of a good eLoran position solution. 
- Verify that the Differential eLoran Reference Station application communicates 
with the LORADD engine by looking at the LORADD Serial Communication 
monitor. 
- In case there is no communication with the LORADD, open Data source and 
connect on COM3@115200 baud 
- Open the TOA log window and verify that the receiver is tracking stations. 
- Verify that the stations are properly cycle identified (last digit in the flag is 0). 
- Open the LCPOSA Autonomous window and verify status.  
- In case the receiver does not track sufficient stations, verify antenna installation 
and cable.  
- Reset the LORADD receiver by issuing the RESET command or press 
Configure Reference Station button. 
 

Q4: The station is turned on, the power, Clock and eLoran LEDs are lit, but the station 
does not calculate any differential corrections. 

A4: - Open the Differential eLoran Configuration window. 
- Verify the settings. 
- Press the Configure Reference Station button, which will reset and reinitialise 
the station. 
- If the station does not start to calculate corrections after reset, open the TOAA 
log window. 
- Verify that the receiver properly tracks the Loran stations with SNR above 5 dB. 
- Verify that the receiver properly tracks the Simulator signal (7823M) with SNR 
above 10 dB. 
- Open the TOA and Differential Corrections Monitor Plot and select TOA view. 
- Select relevant stations and simulator for display, display with Deviation from 
Mean ticked. 
- Verify that the tracks are horizontal and statistics is good (< 15 ns Std) 

 

Q5: The station is turned on, the Communication LED is off.  

A5: The Differential eLoran Reference Station does not communicate with the Eurofix 
Reference Station. 
- Verify that the LAN cable is connected and that the station has access to 
internet. Use Command window and DOS PING command. 
- Verify that the OpenVPN connection is active. If not, restart the OpenVPN 
program. 
- Open the Data source window and verify status of connection. Press connect 
button if disconnected.  
- Verify the Automatic reconnect is ticked t restore connection in case it is lost. 
- If the station has communication with the Eurofix Reference Station the RSIM 
Monitor window should display $PRCM messages on regular intervals. 

 

Q6: The station is turned on and works properly. The Horizontal Position Error status 
gives an alarm. 

A6: - Open the Differential eLoran Position Monitor window. 
- Verify HPL threshold is not too tight (>10m). 
- Verify that the scatterplot is updated with new position information every 5 
seconds. 
- Verify that the Current Data mode is “Differential”.  
- Open the TOA and Differential Corrections Monitor Plot and select TOA view. 
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- Select relevant stations and simulator for display, display with Deviation from 
Mean ticked. 
- Verify that the tracks are horizontal and statistics is good (< 15 ns Std) 
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4 Command and log interface 
As mentioned before, the Differential eLoran Reference Station is based on the 
LORADD Series integrated eLoran/GPS receiver, and takes all command and logs 
from that receiver. Commands to the LORADD engine can be issued through the Serial 
Commands field in the LORADD Serial Monitor window of the Differential eLoran 
Reference Station application. Description of standard commands and logs can be 
found in the manual of the integrated receiver, to be downloaded from the 
reelektronika website, and is listed here for completeness. 

4.1 Differential eLoran Reference Station specific commands 
Commands are entered as space separated commands terminated by a Carriage 
Return <CR>. Commands can be entered using the Serial Commands field in the 
LORADD Serial Communications monitor. Commands are not case sensitive. 
 
The command ‘SETTINGS’ is used to list and/or change various parameters in the 
receiver that influence its operation. The following settings are relevant for Differential 
eLoran Reference Station operation: 
 

TRACKWISHLIST List of Loran IDs the receiver will search for 
SIMULATOR Enables/disables or configures the built-in Loran 

signal simulator 
ANTPARM Sets the H-field antenna calibration parameters 
ANT_UPSIDEDOWN Sets parameter to identify if the antenna is 

mounted upside down 
ECDCOR Sets ECD correction values for Loran stations 
AUTONOTCHES Enables/disables the use of autonotches in the 

receiver 
EFDGPS Enables/disables Eurofix DGPS output in RTCM 

format on COM3 
 
Additional LORADD commands: 
 

SEND Sends a command to a comport 
I2C For internal use 
FPGA For internal use 
ECDCI Antenna control 

 

SETTINGS TRACKWISHLIST 
Syntax: 
SETTINGS SET TRACKWISHLIST <ID1 ID2 ID.. IDn> 
SETTINGS SHOW 
SETTINGS RESET 
 
Description: 
The Trackwishlist is a list of Loran stations that the user wants to track specifically. 
When both UTC time and position are known to the receiver, it can calculate the 
moment in time that the signals of a particular station should arrive at the receiver and 
use that information as a basis to start tracking the station. This is a much faster 
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method of station acquisition than the normal searchlist-based acquisition. The receiver 
compares the list of currently tracked stations with the trackwishlist once every second. 
 
The Loran ID 7823M is a special case: it allows for the simulator to be acquired using 
the TrackWishList, even though it has no fixed relation to UTC. 
 
The TrackWishList holds a maximum of 20 entries. 
 
Example: 
SETTINGS SHOW TRACKWISHLIST 
SETTINGS SET TRACKWISHLIST 7823M 6731M 6731Y 6731Z 7499M 7499Y 
SETTINGS SET TRACKWISHLIST 1111M  

(unknown Loran ID; effectively clears the TrackWishList) 
 

SETTINGS SIMULATOR 
Syntax: 
SETTINGS SET SIMULATOR <GRI>|<OFF> 
SETTINGS SHOW 
SETTINGS RESET 
 
Description: 
Enables or disables the built-in Loran signal simulator generation. Although the GRI of 
the generated signal is programmable, the Differential eLoran Reference Station 
receiver expects the signal to have a GRI of 7823, so this is the suggested setting.  
 
The output signal is available on BNC 1. A PCI trigger signal is available on BNC 3. 
Note that the positive edge of the trigger signal corresponds to T=0, while the negative 
edge of the trigger signal is at T=30 µs. 
 
Example: 
SETTINGS SET SIMULATOR 7823.0 
SETTINGS SET SIMULATOR OFF 
 

SETTINGS ANTPARM 
Syntax: 
SETTINGS SET ANTPARM <G1r G1i A21r A21i G2r G2i A12r A12i> 
SETTINGS SHOW 
SETTINGS RESET 
 
Description: 
Sets the antenna compensation parameters. G1r and G1i are the real and imaginary 
components of the gain for Loop 1. A21r and A21i is the amount of cross-talk that Loop 
1 receives from Loop 2. G21r and G21i form the complex gain of Loop 2. Finally, A12r 
and A12i is the amount of cross-talk that Loop 2 receives from Loop 1. 
 
Example: 
SETTINGS SET ANTPARM 1.0 0.0 0.0 0.0 1.0 0.0 0.0 0.0  

(the default setting) 
 

SETTINGS ANT_UPSIDEDOWN  
Syntax: 
SETTINGS SET ANT_UPSIDEDOWN [ON|OFF] 
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SETTINGS SHOW 
SETTINGS RESET 
 
Description: 
Controls whether the receiver should compensate for the antenna mounted upside 
down, or not. Note: after changing this setting, the setting will be saved to NVRAM, and 
the receiver will reboot automatically to accommodate for the new setting. 
 
Example: 
SETTINGS SET ANT_UPSIDEDOWN ON 
 

SETTINGS ECDCOR  
Syntax: 
SETTINGS SET ECDCOR <HField EField> ECD corrections 
SETTINGS SHOW 
SETTINGS RESET 
 
Description: 
Sets the ECD corrections, both for H-field and E-field antennas. The receiver 
automatically applies the correction for the antenna type that it is told to use. This 
setting applies for all tracked stations. 
 
Example: 
SETTINGS SET ECDCOR 0.5 2.0 
 

SETTINGS AUTONOTCHES  
Syntax: 
SETTINGS SET AUTONOTCHES [ON|OFF|ONCE] 
SETTINGS SHOW 
SETTINGS RESET 
 
Description: 
This setting controls whether the automatic placement of notches is done continuously 
(ON), or is done only once and then frozen (ONCE), or is disabled completely (OFF). 
 
In the ON setting, notch settings are updated approximately once every 5 seconds. 
 
Note that turning the autonotches to OFF disables the automatic placement of notches, 
but any notches that were already activated prior to switching the autonotches to OFF 
are still enabled. To remove any active notches, issue NOTCH CLEAR ALL command 
subsequent to the SETTINGS SET AUTONOTCHES OFF. 
 
The ONCE setting does a spectrum measurement once, and then places the notches. 
After that, the notches are kept in place at their designated frequency and bandwidth, 
but are no longer automatically updated. 
 
Example: 
SETTINGS SET AUTONOTCHES ON 
 

SETTINGS EFDGPS  
Syntax: 
SETTINGS SET EFDGPS [ON|OFF] 
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SETTINGS SHOW 
SETTINGS RESET 
 
Description: 
Controls whether any received Eurofix DGPS corrections should be output to Port 3 (in 
RTCM 104 format). 
 
Example: 
SETTINGS SET EFDGPS ON 
 

Command SEND 
Syntax: 
SEND [COM1|COM2|COM3|COM4] [<data>] 
 
Description: 
Tells the unit to send out a data string over a specific serial port. Can be used to issue 
commands to other devices that are connected to the receiver. A <CR><LF> is 
automatically appended to the ‘data’ parameter before it is sent to the designated port. 
 
Example: 
SEND COM3 LOG COM1 PSRPOSA ONTIME 1 

Command I2C 
There are a number of built-in components into the Differential eLoran Reference 
Station that communicate via an I2C bus. This command is for reading and writing to 
those components directly. This is not part of normal user operating procedures, and 
should only be done at the direct instruction of Reelektronika. 

Command FPGA 
The Differential eLoran Reference Station contains a Xilinx FPGA which communicates 
with the LORADD DSP. The FPGA command is for direct communication to the FPGA. 
This is not part of normal user operating procedures, and should only be done at the 
direct instruction of Reelektronika. 

Command ECDCI 
Syntax: 
ECDCI FLAG <Value> 
ECDCI SAVE 
ECDCI SHOW 
 
Description: 
Sets internal flag value which controls the type of antenna. Value can be decimal or 
hexadecimal (0x00). The different bits in the flag have different meaning: 
 
Bit 0: 0=H-field 1=E-field 
Bit 1: 0=normal 1=Antenna upside down 
 
The new settings only have effect after the command ECDCI SAVE and a reset of the 
receiver (either HW or by command RESET.) 
 
Example: 
ECDCI FLAG 0x01 – configures the receiver to use an E-field antenna. 
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ECDCI FLAG 0x02 – configures the receiver to use an H-field antenna upside down. 
This command is equivalent to SETTINGS SET ANT_UPSIDEDOWN ON 
 

4.2 General LORADD Series Commands 
The following commands can be entered to control the receiver: 
 

HELP Prints help for all supported commands 
VERSION Prints version information 
SHOWSEARCH Shows the current searchlist 
RESET Performs a software reset 
LOG Command to start logs 
UNLOG Command to stop logs 
SETSPEED Sets the speed of a serial port 
READCONFIG Restores configuration from Non-Volatile 

Memory 
SAVECONFIG Stores current configuration into Non-Volatile 

Memory 
RESETCONFIG Restores the current configuration to factory 

defaults 
SETPOSITION Sets an approximate position 
AUTH Enters an authentication code into the receiver 
NOTCH Configures notches 
SETTINGS Controls various settings of the receiver 
LOADREFSTA Loads the Reference Station almanac 

LOADASFMAP Loads the ASF Map  

 

Command HELP 
Syntax: HELP 
 
Response: List of available commands 
 
Syntax: HELP <COMMAND> 

Where <COMMAND> is any valid command 
 
Response: Detailed help on the command 

Command VERSION 
Syntax: VERSION 
 
Response: Version information on firmware 
 
This information is necessary if an error report is sent back to reelektronika. 

Command SHOWSEARCH 
Syntax: SHOWSEARCH 
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Response: Shows the searchlist of the receiver 
 
Example: Current SearchList: 

 
 1: 7499 (  4, 32) 
 2: 6731 (  4, 32) 
 3: 9007 (  8, 64) 

 
Where each line shows the search information for one GRI. The numbers in brackets 
are the minimum and maximum number of GRIs the receiver looks for stations in the 
chain. 

Command RESET 
Syntax: RESET 
 
Response: Start of Program! 
 
Resets the firmware of the Loran engine. The receiver starts with the configuration of 
comport speeds, enabled logs etc. as stored in the non-volatile memory of the receiver. 

Command LOG 
Syntax: LOG <port> <logtype> <trigger> 

Where  
<port> is the destination port of the receiver, e.g. COM1, COM2, COM3 
<logtype> is one of the logtypes as described in Section 3 and 4, always 
without $ sign 
<trigger> is the trigger for generating a new log, e.g. ONTIME <time> or 
ONNEW, with <time> is the update interval in seconds that the log should 
be output 

 
Response: Output of logs 
 
The following table summarizes the possible logs and the possible triggers: 

NMEA logs 

Log Description Triggers 

GPGGA Global Positioning System Fix Data  ONNEW 

GPGLL GPS Geographic position, Latitude and 
Longitude  ONNEW 

GPGSA GPS DOP and active satellites  ONNEW 

GPGST GNSS Pseudorange noise statistics  ONNEW 

GPVTG Course over ground/speed  ONNEW 

GPZDA UTC and local date/time data  ONNEW 

GPGSV GNSS Satellites in view  ONNEW 

LCGLC eLoran Geographic position, Time differences  ONNEW 

LCHDT eLoran Heading  ONNEW 

LCGLL eLoran Geographic position, Latitude and 
Longitude ONTIME  
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reelektronika proprietary logs 

Log Description Triggers 

GPPOSA GPS calculated position ONTIME  

LCPOSA eLoran calculated position ONTIME  

INPOSA Integrated position fix using GPS and/or 
eLoran ONTIME  

LCRSDA eLoran range residuals ONTIME  

TOAA eLoran Time of Arrival measurements  ONNEW 

SMDA eLoran Station measurement data ONTIME  

SSDA eLoran dual loop signal measurements ONTIME  

HDGA Heading measurement  ONNEW 

DASFA Differential ASF measurements ONTIME  

RMSGA Eurofix decoded messages  ONNEW 

RTCMB Binary output of RTCM SC104 DGPS data 
received through Eurofix  ONNEW 

FFTA Frequency spectrum data  ONNEW 

NOTCHA Notch frequency and bandwidth information  ONNEW 

SYNCA eLoran to UTC Synchronisation information  ONNEW 

Command UNLOG 
Syntax: UNLOG <port> <logtype> 

Where  
<port> is the destination port of the receiver, e.g. COM1, COM2, COM3 
<logtype> is one of the logtypes as described in Section 3 and 4, always 
without $ sign 

 
Response: SerialX > 

Where X is the number of serial port the command is entered 
 
Terminates the output of the specified log on the port. 
 
 
 
Syntax: UNLOG <port> ALL 

Where <port> is the destination port of the receiver, e.g. COM1, COM2, 
COM3 

 
Response: SerialX > 

Where X is the number of serial port the command is entered 
 
Terminates the all output on the port. 

Command SETSPEED 
Syntax: SETSPEED <port> <speed> 
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Response: Speed of port <port> now set to <speed> 
 
Sets the speed of a port. Common speeds are: 

2400 
4800 
9600 
19200 
38400 
57600 
115200 (default) 
400000 

 
Please make sure the communications port on the receiving end is configured at the 
same speed. Other settings should be 8 databits, No parity, 1 stopbit, no handshaking. 

Command READCONFIG 
Syntax: READCONFIG 
 
Response: Configuration read OK 
 
Reads the configuration stored in non-volatile RAM previously stored by SAVECONFIG. 

Command SAVECONFIG 
Syntax: SAVECONFIG 
 
Response: Configuration saved 
 
Saves the configuration in non-volatile RAM. Settings that are saved are port speeds 
and enabled logs. The last position is saved automatically to enable a fast start-up 
when the receiver is used in approximately the same location. 

Command RESETCONFIG 
Syntax: RESETCONFIG 
 
Response: None 
 
Resets the current configuration to the factory defaults. All communication port speeds 
are set at 115200 and default logs are enabled on ports 1 and 2. 

Command SETPOSITION 
Syntax: SETPOSITION <latitude> <longitude> 
 
Response: SetPosition: Position set 
 
Sets the approximate position on <latitude> <longitude>. This approximate position is 
needed to generate a searchlist for chains and have a start position for calculating the 
Loran positions. If a GPS position is available, this position will be used as a start 
position to search for Loran chains. If no GPS is available the SETPOSITION 
command will trigger the generation of a searchlist. 

Command AUTH 
Syntax: AUTH <1> <2> <3> <4> 
 
Response: Auth code accepted 
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Enters an authentication code into the receiver. The authentication code enables the 
firmware that came with the receiver or that has been uploaded by the user. Each 
firmware and/or upgrade may have its own authentication code. Each receiver has its 
own unique authentication code. The parameters <1> <2> <3> and <4> are hexadigital 
numbers to be entered. The authentication code will be provided to the user together 
with the receiver. In case an authentication code is lost, please contact 
reelektronika. 

Command NOTCH 
Syntax: NOTCH AUTO [ON|OFF] 
 
Response: Automatic placement of notches is now enabled/disabled 
 
Enables or disables automatic notch setting 
If automatic notch placement is turned OFF, the receiver retains the last notch settings. 
Use NOTCH CLEAR ALL after this command to effectively clear all notches. 
 
 
 
Syntax: NOTCH LIST 
 
Response: Automatic notch placement: ON 

Notches:  
Notch 0: Active Freq: 128.9 kHz; BW = 336.0 Hz 
Notch 1: Active Freq: 77.5 kHz; BW = 568.5 Hz 
... 
Notch 28: Inactive 
Notch 29: Inactive 

 
Lists all currently activated notches 
 
 
 
Syntax: NOTCH SET <r> <freq> <bw> 
 
Response: Notch <r> activated: f = <freq> kHz; BW =  bw Hz 
 
Sets notch number <r> to frequency <freq> (kHz) with bandwidth <bw> (Hz) 
Note that this command is only effective if the NOTCH AUTO is OFF. 
 
Example: NOTCH SET 0 77.5 500 (sets notch 0 to 77.5 kHz, width 500 Hz) 
 
Valid values for <r> range from 0 to 29 
 
 
 
Syntax: NOTCH CLEAR <r>|ALL 
 
Response: Notch <r> deactivated 

All notches deactivated 
 
Clears the setting of notch <r>, or all notches. 
Note that this command is only effective if the NOTCH AUTO is OFF. 
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Example:  NOTCH CLEAR 5 (to disable notch number 5) 

NOTCH CLEAR ALL (to clear all notches) 
 

Valid values for <r> range from 0 to 29 

Command SETTINGS 
Syntax: SETTINGS SHOW 
 
Response: Current settings: 

ANT_UPSIDEDOWN   : OFF 
AUTONOTCHES      : ON 
EFDGPS           : ON 

 
Shows current settings 
 
 
 
Syntax: SETTINGS SET ANT_UPSIDEDOWN [ON|OFF] 
 
Response: Antenna setting is now upside down/normal 

WARNING: The receiver will reset shortly to apply the 
new setting 
SETTINGS: Setting applied 

 
Specifies whether the antenna is mounted upside down or not.  
NOTE: After changing the setting, the receiver will restart automatically! 
 
 
 
Syntax: SETTINGS SET AUTONOTCHES [ON|OFF] 
 
Response: SETTINGS: Setting applied 
 
Turns autonotches ON or OFF. Command does the same as NOTCH AUTO [ON|OFF]. 
 
 
 
Syntax: SETTINGS SET EFDGPS [ON|OFF] 
 
Response: SETTINGS: Setting applied 
 
Turns the passthrough of RTCM SC104 data to the internal GPS receiver ON or OFF. If 
EFDGPS is ON, decoded DGPS messages as received from the closest Eurofix station 
are passed on to the internal GPS receiver. If EFDGPS is OFF the GPS receiver will use 
WAAS or EGNOS data if available. 
 
 
 
Syntax: SETTINGS RESET 
 
Response: Settings reset to defaults 
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Resets the settings to the default values. Note that the ANT_UPSIDEDOWN setting is left 
untouched. Use SETTINGS SET ANT_UPSIDEDOWN [ON|OFF] to change this setting. 
 

Command LOADREFSTA 
Syntax: LOADREFSTA <$PRLK,REFSTAA ,…*CC> 
 
Response: REFSTAA data accepted 
 
Loads the Reference Station almanac needed to interpret the received differential 
eLoran corrections. 

Command LOADASFMAP 
Syntax: LOADASFMAP <$PRLK,ASFMAPA ,…*CC> 
 
Response: ASFMAP data accepted 

ASFMAP complete 
 
Loads lines of an ASF map. 
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4.3 General log interface description 
This Section describes the data interface format. All command and log communication 
is done using one (or more) of the available comports of the UTC receiver. Comports 
can be set at speeds up to 400 000 baud. 
 
The command and log interface as described in this document adheres to the NMEA 
0183 standards for communication between instrumentation aboard maritime vessels. 
The general format of this interface is: 
 
$aaaaa,…,…,…*CC[CR][LF] 
 
where $aaaaa is the header, identifying the log or command, and CC is an optional 
checksum. The reelektronika receivers will output the checksum. The checksum is 
the 8-bit exclusive OR (no start or stop bits) of all characters in the sentence, including 
the "," delimiters, between - but not including - the "$" and "*" delimiters. 
 
The fields in the logs are separated by commas. In contrast to NMEA 0183, most fields 
are variable in size and can be left blank if data is unavailable. Also, the length of the 
loglines is in principal unlimited.  
 
Besides NMEA 0183 defined log formats, the receivers also output proprietary 
reelektronika logs, which all start with $PRLK. Commands are entered as space 
separated strings, not in NMEA 0183 format. In response to a command the receiver 
outputs status information or a prompt on the comport the command is issued. More 
information on the commands will be given below. 

4.4 NMEA 0183 supported logs 
The integrated GPS/eLoran sensor supports general GPS and eLoran position and 
data logs as defined within the NMEA 0183 standard. These are: 
 
Log Description 
LCGLC eLoran Geographic position, Time differences 
LCHDT eLoran Heading 
LCGLL eLoran Geographic position, Latitude and Longitude 
 
The logs above are all described in NMEA 0183 documentation. For more information 
on the formats, definitions of numbers and conventions, the reader is referred to NMEA 
documentation. The following information on the logs has been extracted from there: 

$LCGLC - eLoran Geographic position, Time differences 
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$LCGLC,xxxx,x.x,a,x.x,a,x.x,a,x.x,a,x.x,a,x.x,a*CC 
1 Signal status is: 

B = Blink warning 
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C = Cycle warning 
S = SNR warning 
A = Valid 

 
Sample log: 
$LCGLC,7499,7238.9700,A,14021.7721,A,31696.1800,A*00 
$LCGLC,6731,6750.7446,A,14450.7611,A,42178.2373,A*0A 

$LCHDT - eLoran Heading 
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$LCHDT,x.x,T*CC 

 
Sample log: 
$LCHDT,65.9,T*17 

$LCGLL – eLoran Geographic position, Latitude and Longitude 
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$LCGLL,ddmm.mm,a,dddmm.mm,a,hhmmss.ss,a,a*CC 
1 Status is A for normal operation, V for invalid position 
2 Mode Indicator is: 

A = Autonomous 
D = Differential 
E = Estimated 
M = Manual mode 
S = Simulator mode 
N = No fix data 

 
Sample log: 
$LCGLL,5052.77062,N,00437.01017,E,,A,A*5E 
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4.5 reelektronika Proprietary logs 
Besides the supported NMEA logs for GPS and eLoran the integrated navigation 
sensor also outputs reelektronika proprietary logs. These logs are necessary if the 
user wants to use the sensor at its most accurate and sophisticated level. The NMEA 
0183 logs are then not sufficient to communicate all available and relevant data to 
other equipment. These logs all begin with the header $PRLK. 
 
Additional to the standard LORADD logs, the following log information is available: 
 
Log Description 
MTOAA Multiple eLoran TOA measurements 
HDGLA Station Heading measurements 
TIMETAGA Timetag information 
 
The following standard logs are available: 
Log Description 
LCPOSA eLoran calculated position 
LCRSDA eLoran range residuals 
TOAA eLoran Time of Arrival measurements 
HDGA Heading measurement 
RMSGA Eurofix decoded messages 
FFTA Frequency spectrum data 
NOTCHA Notch frequency and bandwidth information 
SYNCA eLoran to UTC Synchronisation information 
REFSTAA 

ASFMAPA 

Reference Station almanac and ASF Map information 
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MTOAA – Multiple eLoran TOA measurements 
Sample log: 
$PRLK,MTOAA,1.0,532045.00,5,5,FINESTEERING,4.30e-06,-13.02,-13.12,1,10,1, 

7823M,0.0,574,0.93,-4.351,0.000,0,8001,0.000,532034.13,1,3,4,5,5,5,5,5,4,4, 
16.3,111.1507,111.0966,111.0569,111.0275,111.0065,110.9915,110.9811,110.9739, 
110.9679,110.9618,1.4070,1.2542,1.1521,1.0804,1.0293,0.9937,0.9702,0.9549, 
0.9438,0.9325,0.00,0.00,0.00,0.00,0.00*49 

 
PRLK, RLK identifier 
MTOAA, Log identifier 
1.0, MTOAA Log version 
532045.00, Time since receiver start (seconds) 
5, Update interval (seconds) 
5, Integration time (seconds) 
FINESTEERING, Clock steering mode (NOCLOCK, INITIALISING, 

COARSESTEERING, FINESTEERING)  
4.30e-06, Measured clock error 
-13.02, Noise loop 0 
-13.12, Noise loop 1 
1, Number of channels output 
10, Number of zero-crossing tracked 
1, Number of stations output 
 7823M, Station identifier 
 0.0, Station heading 
 574, Number of pulses 
 0.93, Batch quality 
 -4.351, Measured ECD 
 0.000, Cycle-ident quality 
 0, Cycle-ident alarm 
 8001, Hexadecimal Flag 
 0.000, Doppler 
 532034.13, Locktime (seconds) 
 1,3,4,5,5,5,5,5,4,4

, 
Signal strength (one value per zero-crossing) 

 16.3, SNR 
 111.1507,111.096

6,111.0569,111.0
275,111.0065,110
.9915,110.9811,1
10.9739,110.9679
,110.9618, 

TOA values (one value per zero-crossing) 

 1.4070,1.2542,1.1
521,1.0804,1.029
3,0.9937,0.9702,0
.9549,0.9438,0.93
25, 

Ratios (one value per zero-crossing) 

 0.00,0.00,0.00,0.0
0,0.00 

 

*49 Checksum 
 
Trigger: ONNEW 
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HDGLA – Station Heading measurements 
Sample log: 
$PRLK,HDGLA,1.0,116.00,1,1,1,3.49,0.00,1,0,L,146.711,0.00,0.975,6,6731M,102.08

9,281.825,2978.43,248.800,411.96,1.000,...,7499Y,213.476,28.679,483.87,0.186
,20.59,0.000*00 

 
PRLK, RLK identifier 
HDGLA, Log identifier 
1.0, HDGLA Log version 
116.00, Log timestamp (seconds since receiver power-on) 
1, Update Time in seconds 
1, Integration Time in seconds 
1, Position valid (1=true, 0=false) 
3.49, Cycle Ident Pos (5 µs Cycle Ident values) 
0.00, Cycle Ident Neg (5 µs Cycle Ident values) 
1, Ambiguity solved (1=true, 0=false) 
0, Beam Flipped (1=true, 0=false) 
L, Mode (L=Loran) 
146.711, Heading in degrees 
0.00, Heading Std 
0.975, Quality 
6, Num Stations 
 6731M, Station identifier 
 102.089, Beam Orientation 
 281.825, Measured Heading 
 2978.43, Measured Quality 
 248.800, Calculated Heading 
 411.96, Beam over Null Ratio 
 1.000, Weight 
*00 Checksum 
 
Trigger: ONNEW 
 

TIMETAGA – Timetag information 
Sample log: 
$PRLK,TIMETAGA,1.0,1,532042.997760,1424,518392,532043.692979590036*32 
 
PRLK, RLK identifier 
TIMETAGA, Log identifier 
1.0, TIMETAGA Log version 
1, Timetag source (1 or 2) 
532042.997760, Log timestamp (seconds since receiver power-on) 
1424, GPS week 
518392, GPS seconds 
532043.692979590036 Event occurrence in receiver time (in seconds) 
 
Trigger: ONNEW 
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LCPOSA - eLoran calculated position 
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$PRLK,LCPOSA,c--c,hhmmss.ss,ddmmyy,a,a,x.x,x.x,x.x,x.x,x.x,x,x.x,x.x*CC 
1 If UTC time is not available, the internal receiver time since boot is reported 
2 UTC Mode is: 

G = GPS derived UTC 
L = eLoran derived UTC 
N = No UTC synchronisation 

3 LC Mode is: 
C = Coarse position (no cycle identification necessary) 
A = Uncorrected eLoran 
D = Differential eLoran 
G = GPS Calibrated eLoran 
S = ASF Corrected eLoran 
N = No position fix 

4 Compass heading currently not available in this log, use HDGA instead 
5 Quality indicator TBD 
 
Sample log: 
$PRLK,LCPOSA,1.0,1934.00,,N,G,50.8727050,4.6262118,0.2,161.2,,5,2.0,*29 
 
Trigger: ONTIME 
 

LCRSDA - eLoran range residuals 

1 If UTC time is not available, the internal receiver time since boot is reported 
2 UTC Mode is: 

G = GPS derived UTC 
L = eLoran derived UTC 
N = No UTC synchronization 

3 LC Mode is: 
A = Uncorrected eLoran 
D = Differential eLoran 
G = GPS Calibrated eLoran 
S = ASF Corrected eLoran 
N = No position fix 

 

H
e
a
d
e
r
 

L
o
g
h
e
a
d
e
r
 

I
n
t
e
r
f
a
c
e
 
v
e
r
s
i
o
n
 

U
T
C
 
t
i
m
e
 
o
f
 
f
i
x
 
1
 

U
T
C
 
D
a
t
e
 

U
T
C
 
M
o
d
e
 
2
 

L
C
 
M
o
d
e
 
3
 

N
u
m
 
e
L
o
r
a
n
 

e
L
o
r
a
n
 
S
t
a
t
i
o
n
 
I
D
 
1
 

R
e
s
i
d
u
a
l
 
L
C
 
1
 
(
m
)
 

W
e
i
g
h
t
 
f
a
c
t
o
r
 
L
C
 
1
 

e
L
o
r
a
n
 
S
t
a
t
i
o
n
 
I
D
 
n
 

R
e
s
i
d
u
a
l
 
L
C
 
n
 
(
m
)
 

W
e
i
g
h
t
 
f
a
c
t
o
r
 
L
C
 
n
 

C
h
e
c
k
s
u
m
 

$PRLK,LCRSDA,c--c,hhmmss.ss,ddmmyy,a,a,x,xa,x.x,x.x,.....,xa,x.x,x.x*CC 
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Sample log: 
$PRLK,LCRSDA,1.0,1274.00,,N,S,5,6731M,-0.4,1.00,6731X,0.0,0.14,6731Z, 

-1.0,0.49,7499M,0.9,0.49,7499X,0.3,0.99*75 
 
Trigger: ONTIME 
 

TOAA – eLoran Time of Arrival measurements 
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xa,x.x,x.x,x.x,x.x,x.x,XXXX,x.x,x.x,x.x,*CC 

1 The internal receiver time since boot is reported 
2 Quality indicator between 0 and 1, 1 is highest quality 
3 Status is a hexadecimal number which indicates the tracking of the station. Each bit 

in the number corresponds to a signal flag: 
 
0x0001 Cycle Ident not valid 
0x0002 Reserved 
0x0004 Reserved 
0x0008 Reserved 
0x0010 Reserved 
0x0020 Reserved 
0x0040 TOA invalid (TOA set to -1) 
0x0080 Doppler invalid 
0x0100 Reserved 
0x0200 Reserved 
0x0400 Reserved 
0x0800 Reserved 
0x1000 Reserved 
0x2000 Data modulation detected 
0x4000 Reserved 
0x8000 Simulator indicator 
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$PRLK,TOAA,c--c,x.x,x,x,c--c,x.x,x.x,x.x,x,xa,x.x,x.x,x.x,x.x,x.x,XXXX,x.x,x.x,x.x,... 
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Sample log: 
$PRLK,TOAA,1.0,1129.00,5,5,FINESTEERING,7.86e-07,,,6, 

6731M,50.98,16.66,0.777,-0.369,0.780,0000,6750.6586,1.8025e-09,1063.97, 
6731X,38.94,-0.58,0.377,-0.003,0.351,0000,21201.4204,4.0613e-10,1064.98, 
6731Z,50.14,10.28,0.860,-0.895,0.653,0000,48928.8892,1.3639e-09,1064.98, 
7499M,50.32,10.45,0.816,-0.817,0.682,0000,7238.8968,-1.4135e-09,1064.03, 
7499X,51.01,16.68,0.866,-0.421,0.774,0000,21260.6690,1.479e-09,1063.96, 
7499Y,34.07,-6.82,0.312,-0.858,0.346,0000,38935.0639,3.7997e-09,1063.96*79 

 
Trigger: ONNEW 
 

HDGA – Heading measurement 

1 The internal receiver time since boot is reported 
2 Mode is: 

G = GPS derived heading 
L = eLoran derived heading 
I = Inertial derived heading 

 
Sample log: 
$PRLK,HDGA,1.0,1216.00,1,L,65.47,0.0,1.0*58 
 
Trigger: ONNEW 
 

RMSGA – Eurofix decoded messages 

1 The internal receiver time since boot is reported 
2 The Eurofix message of 10 7-bit words is represented as 10 hexadecimal numbers 

of two characters, description of the message content can be found in “Eurofix 
Message Format, Reel-EMF” 

 
Sample log: 
$PRLK,RMSGA,1.0,1605.66,7499Y,61574307711F000C2A63,0,12*78 
 
Trigger: ONNEW 
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$PRLK,HDGA,c--c,x.x,x,a,x.x,x.x,x.x*CC 
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$PRLK,RMSG,c--c,x.x,xa,X--X,x,x*CC 
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FFTA – Frequency spectrum data 

1 Bins are counted in units of 400 kHz/(FFT Points) 
2 Profile count is TBD 
 
Sample log: 
$PRLK,FFTA,1.1,4096,615,820,24,0,127,1,20.9,13.5,-2.0,...*29 
 
Trigger: ONNEW 

NOTCHA– Notch frequency and bandwidth information 

1 The internal receiver time since boot is reported 
 
Sample log: 
$PRLK,NOTCHA,1.0,171130.81,30,13,128.92,0.6867,77.47,0.6338,75.03,0.6457,77.47

,0.6338,127.27,0.5483,80.99,0.5649,80.99,0.5649,118.28,0.5122,128.92,0.6867,
94.67,0.2946,75.03,0.6457,70.92,0.3092,-1,-1,82.74,0.6709,-1,-1,-1,-1,-1,-
1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-1,-
1,-1*07 

 
Trigger: ONNEW 

H
e
a
d
e
r
 

L
o
g
h
e
a
d
e
r
 

I
n
t
e
r
f
a
c
e
 
v
e
r
s
i
o
n
 

F
F
T
 
p
o
i
n
t
s
 

S
t
a
r
t
 
b
i
n
 
1
 

N
u
m
 
b
i
n
s
 
1
 

I
n
t
e
g
r
a
t
i
o
n
 
c
o
u
n
t
 

P
r
o
f
i
l
e
 
c
o
u
n
t
 
2
 

G
a
i
n
 
s
e
t
t
i
n
g
 

N
u
m
b
e
r
 
o
f
 
F
F
T
 
c
h
a
n
n
e
l
s
 

F
F
T
 
v
a
l
u
e
 

N
e
x
t
 
F
F
T
 
v
a
l
u
e
 

C
h
e
c
k
s
u
m
 

$PRLK,FFTA,c--c,x,x,x,x,x,x,x,x.x,...*CC 
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$PRLK,NOTCHA,c--c,x.x,x,x,x.x,x.x...*CC 
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SYNCA– eLoran to UTC Synchronisation information 

1 The internal receiver time since boot is reported 
2 Synchronisation source can be  

LORANUTC = sync information derived from received Eurofix UTC message 
(depending if the service is available in the area of operation) 
GPSPPS = sync information is derived from an external GPS 1 PPS signal fed into 
the receiver (only available on UTC and ASF measurement equipment) 

3 Receiver samplecount (with fraction) in units of 2.5 µs of the exact UTC second 
4 Indicates of the date and time are represented in UTC time (1=UTC, 0=No UTC) 
5 Number of leap seconds between the UTC source and UTC time. At the moment of 

printing of this manual GPS is 14 seconds ahead of UTC, Loran is 23 seconds 
ahead of UTC. Note that the leap seconds are already applied in the UTC date and 
time presented 

6 Applied offset to compensate for propagation time from transmitter to user, also 
already used in the reported UTC time. 

7 Loran station ID of the station of which the UTC information is derived 
 
Sample log: 
$PRLK,SYNCA,1.0,1676.97,LORANUTC,2006,06,01,08,57,24,671653990.473579,1, 

23,0.0,7499M*30 
 
Trigger: ONNEW 

REFSTAA & ASFMAPA - Reference Station Almanac and ASF Map format 
In the US format [LDCC-06], a differential eLoran user also needs to receive eLoran 
Almanac messages. These messages contain information such as the transmission 
order (assignment of correction number to a Loran rate), the Reference Station position 
and the nominal ASF values for all corrected Loran rates. For the time being, within the 
Differential eLoran implementation using Eurofix it is chosen to provide the 
transmission almanac together with the ASF Corrections map to the users, instead of 
implementing a broadcast almanac. The user needs to upload the Reference Station 
almanac configuration together with the “published” ASF map to its receiver. The 
receiver will then correct its measured eLoran ranges with the ASF value 
corresponding to its position for each Loran station, corrected with the most recently 
received differential eLoran correction.  
 
The REFSTAA log contains the following information: 
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$PRLK,SYNCA,c--c,x.x,c—c,x ,x ,x .x ,x ,x ,x.x,x,x ,x.x,xa*CC 
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The ASFMAPA log contains the following information: 

 

 
Note that the nominal ASF values for the ASF map and Reference Station need not 
necessarily be the same. 
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$PRLK,REFSTAA,1.0,Harwich,100,51.94575504,1.28561571,6731M,0.5900,...,7499M,0.0800*35 
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Annex A. Eurofix Differential eLoran Correction Format 
The Eurofix message format allows for 56 bits payload in a 30 GRI message length. 4 
bits indicate the message type of which Table 1 gives an overview. Message types 10 
and 11 are reserved for differential eLoran operation. Differential eLoran trials in the US 
use the 9th pulse data channel implementation to broadcast differential corrections. For 
compatibility reasons, the differential eLoran correction format in Eurofix is based on 
the bit assignment used in the US trials [LDCC-06]. Table 2 shows the bit assignment 
used in these trials. As can be seen, the Eurofix payload content is larger than the US 
9th pulse payload content and leaves room for one additional correction per message. 
This may prove important if data channel capacity demand increases with the 
implementation of a differential eLoran service on multiple harbours in the UK and 
Europe.  
 

TABLE 1. EUROFIX MESSAGE DESCRIPTION AND STATUS 

Message 
Type 

Bits Description Status 

1 0001 Eurofix DGPS correction (single sat) Fixed 

2 0010 Eurofix DGlonass correction (single 
sat) 

Fixed 

3 0011 Reserved Reserved 

4 0100 Eurofix Station ID/Health message Tentative 

5 0101 Short Message Service (SMS) Fixed 

6 0110 Loran UTC Message Tentative 

7 0111 Reserved Reserved 

8 1000 EGNOS TRAN Tentative 

9 1001 Reserved Reserved 

10 1010 Differential eLoran Phase 
Corrections 

Tentative 

11 1011 Differential eLoran Almanac data Tentative 

12 1100 Reserved Reserved 

13 1101 Reserved Reserved 

14 1110 Reserved Reserved 

15 1111 Reserved Reserved 

16 0000 Reserved Reserved 
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TABLE 2. DIFFERENTIAL ELORAN TYPE 10 – PHASE CORRECTIONS 

Field Bits # bits Units Range Remark 

Eurofix ID 1-4 4  16 1010 

Reference 
Station 

5-14 10  0-1023  

Correction 
Number 

15-17 3  0-7 Correction  Number 
Identification Code 
000 = Cor 1,2 
001 = Cor 3,4 
010 = Cor 5,6 
011 = Cor 7,8 
100 = Cor 9,10 
101 = Cor 11,12 
110 = Undefined 
111 = Undefined 

Sky Wave 
Warning   

18 1  0-1 0 = No warning 
1 = Warning 

Time Base 
Quality 

19-20 2  0-3 Quality of Time Reference 
at Differential eLoran 
Station 
00 = Level 1: <15 ns (rms) 
01 = Level 2: 15-40 ns 
(rms) 
10 = Level 3: 40-200 ns 
(rms) 
11 = Level 4: > 200 ns 

Age of 
Correction 

21-23 3  0-7 Time since last correction 
update 
000 = < 6 minutes 
001 = 6-20 minutes 
010 = 20-60 minutes 
011 = 1-3 hours 
100 = 3-6 hours 
101 = 6-12 hours 
110 = 12-24 hours 
111 = > 24 hours 

Correction 1 24-34 11 2 ns -2.046 – 2.046 
µs 

All ones indicates do not 
use 

Correction 2 35-45 11 2 ns -2.046 – 2.046 
µs 

All ones indicates do not 
use 

Spare 46-56 11    

CRC 57-70 14   Eurofix CRC 

Total:  70    
Message type 10 contains the broadcast of differential eLoran data over the Eurofix datalink. The data 
content is compatible with the data content of the US Loran Data Channel Communications using 9th Pulse 
Modulation 
[LDCC-06]. 
 


